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DISCLAIMER

While every effort has been made to ensure that the product is accurate and reliable within the limits of the current state of the art, NOAA cannot assume liability for any damages caused by inaccuracies in the product or as a result of the failure of the product to function on a particular system. NOAA makes no warranty, expressed or implied, nor does the fact of distribution constitute such a warranty.

The user must be cautious when using this computer program and associated data. As in any complex scientific effort, errors can be expected.

TRADEMARK ACKNOWLEDGMENTS

In this documentation for GeoVu, trademarked commercial products and companies are named. Mention of a commercial company or product does not imply endorsement by NOAA or the Department of Commerce. Use for publicity or advertising purposes of information from this publication concerning proprietary products or the tests of such products is not authorized.

Throughout the publication, rather than put a trademark symbol in every occurrence of a trademarked name, we state that we are using the names only in an editorial fashion with no intention of infringement of the trademark.

CONVENTIONS

You will find the following typographic conventions throughout this guide. The sections of this document which are marked by @ will also be found in the HELP panels viewed while running GeoVu.



Small Caps�Dialog box titles you will see while running GeoVu.��bold�Boldface words represent titles, keywords, literal strings, fixed file names, and menu item names.��italic�Special terms used in this guide. Also place holders for information you must provide. ��typewriter�Presentations of text file contents.���Table of Contents
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��Part One – Getting Started

Installing GeoVu

The GeoVu application is available on the following platforms:



Under Microsoft Windows, GeoVu operates on any IBM PC 386 or 486 or compatible personal computer. The minimum configuration is DOS 5.0 running Microsoft Windows 3.1 in enhanced mode and having a Windows�supported mouse device. A Windows-supported video system of VGA or better resolution is required, and optionally, a CD-ROM drive and standard CD-ROM file access software.



GeoVu is also available as a MOTIF 1.1 program running on SUN Sparc workstations and as a MOTIF 1.2 program running on SGI workstations.



A version for Apple Mac is also available. We suggest a 68020-based machine (Mac II or later) with a color monitor, 4 MB of RAM, and System 6 or later. 



GeoVu Data Sampler is a data collection compiled for use with GeoVu demonstrations and tutorials. GeoVu access software and the GeoVu Data Sampler are available on diskettes or as files accessible via anonymous ftp.



FTP Access: A computer connected to Internet and supporting the ftp command can be used to download GeoVu files. Type ftp ftp.ngdc.noaa.gov. Log in using anonymous for the name; use your own e-mail address or local login name. GeoVu access software is found in the directory Solid_Earth/Access_Tools/GeoVu; GeoVu Data Sampler is found in the directory Solid_Earth/Access_Tools/GeoVu/Sampler. These directories contain executable and binary files which must be downloaded in binary mode. Be sure to look at the ASCII README files found there for installation instructions.

GeoVu is available on-line from the World Wide Web:

ftp:://ftp.ngdc.noaa.gov/Solid_Earth/Access_Tools/GeoVu

To install GeoVu for PC from diskettes:



Insert the diskette into the appropriate disk drive.



Run the program SETUP found on the diskette. If Windows is running, use the Program Manager File menu to select Run. If a: is the drive used, type a: setup in the Run dialog. If Windows is not running, type win to run Windows.



Follow the installation instructions on the screen. The contents of the GeoVu distribution diskette are copied to your hard drive in the directory of your choice.



To install GeoVu for Motif from our ftp file:



The file geovu.tar.Z is a compressed tar file containing the GeoVu executable and associated files. Download this file in binary mode and place it in the directory where you wish to install GeoVu (typically your home directory).



Then enter the following commands:

	uncompress geovu.tar.Z

	tar xvf geovu.tar

This generates a geovu/ directory and a simple file g2. This g2 file is an X applications defaults file to be put into your home (~) directory.



The geovu directory is what should be pointed to by the environment variable GEOVUDIR. For example, if you use the C Shell, put the following line in your .cshrc:

		setenv GEOVUDIR ~/geovu

Of course, this assumed you un-tar'd geovu.tar in your home directory - though this is not necessary. The GeoVu executable is called g2.



To install GeoVu for Macintosh from ftp downloaded file (also World Wide Web):



In ASCII text mode, get the file geovu.sea.hqx. Depending on the setup of your FTP or Web software, the entire decoding and installation may take place automatically, installing the geovu folder onto your hard disk. If only the geovu.sea.hqx file is installed, decode this file with StuffIt Expander or BinHex. These are free software utilities available in many places including: http://hyperarchive.lcs.mit.edu/HyperArchive.html. Double-click the geovu.sea icon to install the geovu folder anywhere you like on your hard drive.



�To install GeoVu for Macintosh off a PC CD-ROM:



Copy the file geovu.sea.hqx to your hard drive. Because the CD-ROM was made on a DOS-based computer, this name is truncated to something like geovu_se.hqx or geovusea.hqx. Decode this file with StuffIt Expander or BinHex. These free software utilities available in many places including: http://hyperarchive.lcs.mit.edu/HyperArchive.html. Double-click the geovu.sea icon to install the geovu folder anywhere you like on your hard drive. (This may have happened automatically, depending on your StuffIt settings.)



You will have to convert the ASCII menu files to Macintosh end-of-lines (EOLs) with a small utility we provide in the installation package. This only works by Drag & Drop: drag the menu file (a file ending in .men) onto the Make Mac EOL application and click the Mac (CR) radio button.





Questions? Contact Allen Hittelman at NOAA's National Geophysical Data Center:

Phone: 303-497-6591

Fax: 303-497-6513

Internet: amh@ngdc.noaa.gov.

Starting GeoVu

To start GeoVu as a Windows desktop application, double-click on the GeoVu icon.



To start GeoVu for Motif, enter the command g2 from the Xterm window prompt, if your current working directory is the GeoVu directory. To start GeoVu as a desktop application, use your X window manager’s icon binding tool to set up the icon. Then click on the GeoVu icon.



To start GeoVu for Macintosh, double-click the GeoVu application icon found in the GeoVu folder.

�@Preparing Data For Use With GeoVu

In order to work with a data file, GeoVu needs to know information about the data including format and type. The data file does not require special formatting or reprocessing to be displayed in GeoVu, but the appearance of the data must be described in accessory files that are used by GeoVu as it runs. If these are not provided, it is possible that GeoVu will be able to continue using the default information and information that you type into dialogs during the session.



For data collections that reside on a CD-ROM, a menu (.men) navigation file is written by the data provider. When this file is provided, it specifies the data type, the format of the input data, and other information. The GeoVu Tools Reference Guide details how to customize GeoVu and how to link it to new data products. The most recent .men files available for our data collections, including corrected files, are also available from our ftp location.

Part Two – Running GeoVu

Pull-down menus are a familiar part of any windowing application. They appear at the top of the application window and each displays a family of commands when you click on it. The GeoVu menus are File, Edit, Search, GeoReference, Utilities, Windows, and Help. (Older releases also had the Documents menu.) Under Microsoft Windows, Help is also available by pressing the function key F1. The Help Contents panels shown are the same text that is Part Two of this document.

@Prepare the GeoVu Session

GeoVu uses its own general methods to find, search, store, and display data. External descriptions of specific data, as files and as collections, provide levels of compatibility with GeoVu's features and operations. A fully GeoVu-compatible data collection is described by a menu file. The menu file contains keywords used to customize access to data, providing data-specific equivalents for GeoVu's own general methods. Reasonable defaults for the keywords are in place so that many data sets can be accessed without a menu file description. Some GeoVu keywords are found as environment variables (Unix or Windows) or stored in the application's Windows initialization file, freeform.ini, or Macintosh preferences file, GeoVu Prefs.



In addition to the menu files, GeoVu reads FreeForm data description files, files containing color palette definitions, and other accessory files that determine the details of your GeoVu session. See “GeoVu Accessory Files”.



�The first time your run GeoVu, or whenever you install compatible data collections, or whenever you wish, you can reconfigure GeoVu to use defaults for your session. Your first task should be to update GeoVu's list of available data sources. This list of data sources is used throughout a session in the user interface. It is written and maintained by GeoVu in an editable text file called cdm_serv.lst, placed in the GeoVu working directory. GeoVu manages this file automatically; you select the Edit menu item Data Source List... to create or update the list to match your installation.



By editing the cd_driver line found in this file, you can also customize the default data home directory (Windows and UNIX), drive letter (Windows), CD-ROM device name (UNIX), or CD-ROM volume name (MAC). Use the syntax and specification appropriate for each machine type.

@File Menu

Select or release a data source, open or close a data file, or quit GeoVu. This menu is used to select data sources as working data ready for use during the session.



Usually you will set a data source, open one or more data files, then use the Search menu to prepare views of the data.

Set Data Source

A Data Source is a collection of data sets, found on a CD-ROM or on hard disk. The Set Data Source menu item lists the available data sources supported in your currently installed configuration. You may select one as the source of working data. If you do not see expected sources listed, use the Edit menu item Data Source List... to update GeoVu's source list file.



GeoVu can run with no source list file or with an empty list; the only data source will be Disk Files. In this case, GeoVu skips the Data Source dialog and directly presents you with the standard Windows, Mac, or MOTIF Open File dialog.



�

Data Source�XE "Data Source"�

Once you select the menu item Set Data Source, a list of available data sources appears. The list always includes the choice Disk Files for data which is not part of any collection accompanied by a GeoVu menu file. Data file descriptions make it possible for GeoVu to access data in files, but this is only the first level of compatibility with GeoVu that is possible. Select Disk Files to open these data files on disk. This choice disables the CD or Data Drive editing box and presents you with the standard Open File dialog, titled Select Data File.



At the next level of GeoVu compatibility, menu navigation through a collection of datasets is provided by a menu file, insulating you from directory paths and file names. Select the name in the list to use one of these collections or CD-ROM products. If the name you want is missing, you need to customize your installation or find a missing .men file. Place menu files in the GEOVUDIR location. See Edit menu item Data Sources...



If you select one of the CD-ROM volumes or data collections, you may need to change the drive letter in the CD or Home editing box (for PC, e.g., S:)(for Unix, e.g., /cdrom1). If the CD volume found in the drive is not the one selected, you are prompted to insert the correct CD. If the data collection selected is not found on the drive, you will see a warning message. On the Macintosh, the name of the CD or the hard disk location where the data is located must be correctly typed (though not case sensitive) into the editing box. This is different for every CD you insert and is the drive name that appears on the Mac desktop.

Introduction  (For Data Collection or CD Access)�XE "Introduction  (For Data Collection or CD Access)"�

When you select a data source by title, you will see an INTRODUCTION screen, which gives some information about the CD or data collection. Continue by using the OK button to return to the main GeoVu menu, or click the Open Data... button to go immediately to the Open Data dialog.

Close CD Data Source

When many sources are open, Close CD Data Source is used to unload the GeoVu links to the CD, removing the menu navigation system for that CD. This clean-up makes room for new sources to be set. To use the same CD-ROM drive but a new CD in it, also close the previous CD’s open files.

Open Data

The menu item Open Data becomes available only after a data source has been selected using Set Data Source. After opening a file, you can retrieve data and view them using the Search menu.



Note that there is a limit to the number of files that can be open at once. This limit may be 13 or 14 files under Windows, and it is possible that GeoVu will be able to open a data file but unable to open the header file or some other associated file. GeoVu is not able to check for all possible combinations, which may lead to unexpected results. It is best to close files that are no longer of interest.

Select Data File  (For Disk File Access)�XE "Select Data File  (For Disk File Access)"�

A standard Windows, Macintosh, or MOTIF Open File dialog appears if the data source is Disk Files.

Open: Title  (for Data Collection or CD-ROM Access)�XE "Open\\: Title  (for Data Collection or CD-ROM Access)"�

�



If the data source selected for Open Data is a CD or special data collection, GeoVu provides hierarchical menu navigation. A dialog is displayed with the source title as the window's title. It guides you through selecting subsets of data from title lists. This menu guide provides a mechanism for finding the data you want without knowledge of the specific directory structure or file names used on the CD or disk.



Facts:  Display information about the highlighted item in a text dialog.



View:  Display the selected ASCII data or text file. This button is disabled if not applicable.



<<Prev:  Return to previous group if there is one or return to the Introduction.



Next>>:  Display the names of the next group.



OK:  Select the highlighted item. Double-clicking the item also selects it. If the selected item is a data set, it is opened by GeoVu.



CANCEL:  Close the dialog without making a selection.

Facts (for Data Collection or CD-ROM Access)�XE "Facts (for Data Collection or CD-ROM Access)"�

<<Prev:  Display information for the previous item in the menu list.



Next>>:  Display information for the next item in the menu list.



CANCEL : Close the Facts window and return to the menu guide.

View (for Data Collection or CD-ROM Access)�XE "View (for Data Collection or CD-ROM Access)"�

This display is possible only when a text file has been selected from the lists. The file may be a description file or ASCII data.



<<Prev:  Display information for the previous item in the menu list.



Next>>:  Display information for the next item in the menu list.



CANCEL : Close the Data window and return to the menu guide.



Using the dialogs discussed above, a specific data set has been selected for use. Before GeoVu proceeds, it checks for a special preview capability. If a summary image of the data has been provided and the GeoVu keyword preview has defined to be Yes, the preview image is displayed. You can continue on to create searches of the actual data after dismissing the preview. Preview data corresponding to large data sets are useful as summary information, providing an overview before time is spent retrieving unconstrained data.

Preview�XE "Preview"�

Preview shown. Do you want this data set?

No:  Delete the preview image and close the preview data. GeoVu returns to the menu guide.

Open+Disp:  Open the selected data set and display it using default settings. This search retrieves all data.

Open Only:  Open the selected data set. You will need to define the search using the Search menu item Create.

Format Type�XE "Format Type"�

GeoVu attempts to determine the format of the data sets before they are opened. If it fails to find the information, the Format Type Dialog appears. This dialog lists available common formats plus an UNKNOWN option. If the data file is in a non-standard format, select UNKNOWN, which allows you to continue and enter the necessary information.



See the GeoVu Accessory Files for information about the standard formats list file stdform.nam.

Data Type�XE "Data Type"�

If GeoVu cannot determine the data type of the input file, this dialog appears. Select one of the three types of data known to GeoVu: Image or Raster, Vector, and Point. In the current GeoVu release, vector data capabilities are not complete.



As GeoVu prepares to open an image data file, the attributes of the image are found. These include: image name, number of rows, number of columns, number of bands, data type, number of bytes per pixel, format, projection, pixel size, and map coordinates of the image boundary. If essential information is not found, the attributes of the image are displayed automatically using the Image Information dialog discussed below, as you can also access it from the Edit menu. You must type in the missing information. Changes made affect future searches and displays of the image data, but do not the revise the current displays. Also, these changes will be lost when the GeoVu session ends.

Close Data

Closes an open data file and cleans up GeoVu references to it. Close Data does not close the graphical display windows for the data. This item is disabled when there are no open files.



Note that there is a limit to the number of files that can be open at once. This limit may be 13 or 14 files under Windows, and it is possible that GeoVu will be able to open a data file but unable to open the header file or some other associated file. GeoVu is not able to check for all possible combinations, which may lead to unexpected results. It is best to close files that are no longer of interest.

Open Files List�XE "Open Files List"�

Select one or more file to close from the list of open files.

Exit GeoVu

Exit GeoVu �SYMBOL 45 \f "Symbol"� no dialogs are presented.

@Edit Menu

Data Header

This menu item allows you to view and modify (edit) items found in a data file header of an open data source.

Resource List�XE "Resource List"�

If more than one file is opened, select one from the list that appears.

File Header�XE "File Header"�

This dialog displays the items from the header and their current values. Any of the values can be modified by typing over the values.



PG UP:  Display the previous 10 items.



PG DOWN:  The dialog displays 10 items at once. If the header contains more than 10 items, click this button to display the next 10 items.



OK:  Save the changes to the header and quit the File Header dialog. If  the data set is an image, the modified Image Information dialog is displayed.



CANCEL:  Quit without saving the changes.

Data Formats (release 6 or later)

This menu item allows you to view and modify (edit) items found in a format description for an open data source.

Image File Information...

Image Information�XE "Image Information"�

You may check and correct each item. Information that is unknown is shown with the special value -9999. Often you will see this value for the number of rows and columns. Select MODIFY and enter the correct numbers. Also GeoVu may make assumptions about the header or the existence of an embedded header. If these defaults are not correct, you may wish to set the header length to 0 or to the correct value. The information shown in this dialog may indicate that GeoVu is not finding format or other files you need to automate correct access to your data. Select the LIST buttons to display a list of choices for each attribute.



The Image Information dialog appears automatically when needed but you can also access it using the Edit menu item Image File Information... This lets you review and change image information for subsequent image file access.



MODIFY:  Allow the fields to be edited for corrections. If some changes are made in the edit boxes, clicking this button again will reset the boxes back to current values. Note the warning message! Select the LIST option to present a list of choices for each attribute.



OK:  Accept the modifications as shown and use it to open and read the data. This button is disabled if there are no changes and the dialog is for information only.



CANCEL:  Dismiss the dialog, without making any changes.

Data Source List

In addition to disk file access, GeoVu depends on a list of available special data collections, each of which is fully GeoVu-compatible and described by a GeoVu menu file. This list of data sources is used throughout a session in the user interface, but it may need to be customized or updated when you first install GeoVu or new compatible data products.



The purpose of this menu item is to update and maintain the data source list. The newly updated list is immediately available for the GeoVu session in progress.

Data Source List Management�XE "Data Source List Management"�

GeoVu searches for possible data collections by finding menu files in the GeoVu working directory. Note that these files end with a .men extension, on all platforms. These possible data sources are compared to the current data sources list available to GeoVu. The result is shown in this dialog in two lists, those sources found on the list and those found in the directory but not on the list.



The name used on the lists is determined by the file name or a title name provided inside the file. If a title name is given in the menu file under the section called CD_MENU_NAME, GeoVu uses this name on the lists. If the CD_MENU_NAME section was not included, GeoVu uses only the base file name.



The GeoVu Directory is given. (If this path is not what you expect, you may need to correct the setting of the GEOVUDIR symbol.) This is where the .men files must reside. Older versions of GeoVu allowed menu files to be placed in other directories and this dialog had a Change Directory feature. 



The Title edit box allows you to change the logical name of a data source. This is the name used in the Set Data Source dialog. When you select an item from NOT on Data Source list, its name appears in this edit box and the ADD button becomes available. You must edit the name in the edit box before pressing the ADD button. The new source is added with the logical name as it appears in the edit box.



DELETE:  Remove the item selected in Sources on list from the sources list. NOTE: If an item was once set as a Data Source during your GeoVu session, you will not be able to delete it here.



AddALL:  Add all items listed in Sources not on list to the sources list.



ADD:  Add the item selected in Sources not on list to the sources list.



OK:  Save the contents of Sources on list to be the sources list and make this list immediately available for access.



CANCEL:  Close the dialog, making no changes to the data sources list.

Preferences (release 6 or later)

Your GeoVu session can be controlled by a few settings found in the Preferences dialog. Note the GeoVu Directory is shown to you here. This dialog will also show you the values found for GeoVu keywords associated with an open data set. If no data set is yet opened for use, the View Data Keywords button will be disabled. This dialog is under construction in Release 6 of GeoVu.

@Search Menu

A Search defines the retrieval and display properties of a data set. Those include geographic bounds, scaling method, display type, palette name, etc. This menu allows you to create, revise, or delete a Search definition, and to display the data according to the criteria of the Search. 

Create

To access and display an open data set, you must first create a Search. Each data type (vector, point, raster / image) requires different dialogs to completely specify the criteria of the data search, data processing, and the resulting product.

Data Source Selections�XE "Data Source Selections"�

If more than one data set is open, this selector appears when Create is selected. The data set opened most recently is at the bottom of the list. You must chose one set to be the current working set.



�

Image Search Parameters  (for image data only)�XE "Image Search Parameters  (for image data only)"�

This dialog allows you to set the criteria of the search. The initial values shown are the defaults which are set automatically. If this dialog is activated by the menu item Revise, the current parameter values are displayed. You can change any of these parameters.



Search Name:  The title which will appear on the display windows and in selection lists. The default is the same as the data source name.



Palette Name:  This list gives the palettes currently supported by GeoVu. Select the one which is most suitable for your data.



Scaling Type:  Select a data scaling method for image data. The GeoVu default is to use 16 colors, so data must be scaled to 0-15.

Linear scaling bins the data evenly by 16 equal intervals between the data minimum and maximum.

In the current version of GeoVu, Frequency is never available.

�The Linear about 0 selection will divide the data into two sets of bins scaled above and below the value 0. This is useful for displays of elevations above and below sea-level and topography of coasts.

Histogram equalization (Histo-Equalized) scales the image data so that each bin contains roughly the same number of pixels.



View Type:

Image or Map will result in an image display.

Table presentations are not yet implemented.

Save Search Definition Only will save the current Search by name without creating a display or file.

Select the option Write To Disk File to create a new file on your hard disk containing the data found when searched according to the criteria.



Set Search Parameter Limits:  This button will call the appropriate dialogs used to define the area of data to be displayed.



OK:  Accept the names, types, and search limits defined and produce the View Type.



CANCEL:  Quit the dialog without saving the current Search definition.

Image or Map Area Definition  (for image data only)�XE "Image or Map Area Definition  (for image data only)"�

This dialog appears when you choose the Set Search Parameter Limits button in Image Search Parameters and is used to set the area to be displayed or retrieved.



Coordinate System:  Allows you to select either map or image as the coordinate system type used for the display area. If the image is not georeferenced, GeoVu will disable the map option.



Start Column No (for image coordinates only) / Left LONG (for a Lat/Long projection only) / Left Map X (for other map projections)  This slide bar allows you to set the horizontal coordinate of the left side of the display area.



End Column No / Right LONG / Right Map X  Allows you to set the horizontal coordinate of the right side of the displayed area.



Start Row No / Top LAT / Top Map Y  Allows you to set the vertical coordinate of the upper side of the display area.



End Row No / Bottom LAT / Bottom Map Y  Allows you to set the vertical coordinate of the lower side of the displayed area. rich



Band to display:  This slide bar is used to specify which band is to be displayed when the data file contains more than one band.



Reduction Scale:  This editing box is used to set the reduction scale of display data. The default value is [(number of pixel-1)/(2048*2048)]+1, since 4,194,304 = 2048*2048 is the largest image size GeoVu currently allows.



Display Direction:  Sets the row and column sequencing of the display image. You can change the direction by selecting the LIST button to view a list of directions: Normal, Inverse Column, Inverse Row, Inverse Row and Column



OK:  Quit this dialog saving the changes made and go back to the Image Search Parameters dialog.



CANCEL:  Quit this dialog without saving changes and go back to the Image Search Parameters dialog.

Plots:Title  (for point data only)�XE "Plots\\:Title  (for point data only)"�

Search Title: the title default will be the name of the data source. Edit this title to save search definitions with unique names for use again later.



Terms: any information available about the data variables selected below will be displayed.



X variable names list: use this drop-down list to select a variable name from those available.



Y variable names list: use this drop-down list to select a variable name from those available.



Set Output/View Type:

Simple XY-Plots  places the results of the search in an XY-Plot.

Multiple XY-Plots  an XY-Plot of several Y variables (Implemented only in Release 6 or later.)

Save Search Only  keeps a definition for the search criteria by name.

Write To File  places the results of the search into a disk file.

Show Values Table  has not yet been implemented.

Set Constraints  allows you to set one or two additional variable constraints and to limit the X and Y variable range. 



GO!  is enabled when GeoVu has complete Search criteria and is ready to produce the plot / search / file / table requested.



Get More Points  will be enabled when GeoVu has searched data retrieving the maximum number of points allowed. More points, up to the maximum number again, can be retrieved using the same search.

Plot Axes and Constraints  (for point data only)�XE "Plot Axes and Constraints  (for point data only)"�

Set Constraints above will call up this dialog, used to specify one or two constraints on the data to be displayed. You can define a range for each variable by entering a minimum and a maximum limit. No limits are imposed if both are set to 0. GeoVu will search for data records in which the first constraint variable, the second constraint variable, the X variable, and the Y variable are all within their limits and will plot the values of X and Y variables as a coordinate pair.



X axis:  set the range for the horizontal axis of the plot.



Y axis:  set the range for the vertical axis of the plot.



First:  set the first constraint variable name and set its range.



Second:  set the second constraint variable name and set its range.



Example: A plot of temperature vs. precipitation may be constrained by limits placed on the LAT and LONG variables associated with the data records, restricting geographical area.



GeoVu finds variable names in the data format information and makes a list of them. It tries to use X, Y, LAT, LONG, or the first names it finds on the list as the default names to use in this dialog.

Variable List�XE "Variable List"�

Variables may also be set by clicking the associated LIST button to get to the Variable List dialog. All available variables are listed by name for you to select by double-clicking the variable name or by selecting OK.

OK: Quit the dialog and replace the variable with the one highlighted in the list box.



CANCEL: Quit without changes.



Terms: An explanation of the highlighted variable is presented if a text file was provided for use with this feature. See “GeoVu Accessory Files” and GeoVu Keywords, term_definition.

Output File Information�XE "Output File Information"�

If the view type in the Image or Plots dialogs is set to be Write To Disk File, use this dialog to provide information that is needed to write a new disk file.



File Name:  Specify the output file name. The default file name is shown. This file, without a full directory path, will be created on the current default directory. You can change the file name or add a complete directory path and name.



Data Type:  Select the type of file, binary or ASCII, to be written. The default type is the same as the input file. The default file extension used for binary data is .bin; for ASCII data it is .dat.



Header Type:



None  No data header will be created. The metadata is lost, so the output file will be not readable by GeoVu.



GeoVu  A header defined by GeoVu will be created in a separate file. The default file extension used for the header file is .hdr. The output data file will be readable by GeoVu.



Native  A header will be created using the header format of the input dataset. Information needed for GeoVu compatibility and which cannot be written into the native header will be placed in an equivalence file, having the file extension .eqv.



Output Lat/Long/Value File launches the program grid2xyz. This program is only available for Windows.



OK:  Accept the choices and begin the data processing.



Cancel:  Quit without processing the data.

Processing Information�XE "Processing Information"�

The Processing dialog appears while you wait for the resulting display (or file-writing) and shows the progress. No response is needed, but a CANCEL button is provided if you wish to interrupt the processing.



If an XY Plot is being displayed, you will see a note in the Processing dialog reminding you of the maximum number of points GeoVu will plot. Before the processing finishes, you will be presented with the dialogs below to use to set plotting attributes such as marker types and colors.

Revise

Change properties of an existing Search. The dialogs that are encountered for the Revise menu item are the same as presented for Create; please see Create above.



Be sure to give the new Search a unique name and delete the original Search if you wish.

Delete

Remove a Search that will not be used again.

Search Selection List�XE "Search Selection List"�



If more than one Search has been specified, this dialog presents a list of available searches. Choose by name from the list presented. Your choice will be deleted.

Display

Display the results of a Search. You may not get what you expect if one Search exists, another data file has just been opened, and you select Display form the Search menu. If no Search definition has been created for the new data set, you get a display of the Search that already exists.

Search Selection List

If more than one Search has been specified, this dialog presents a list of available searches. Choose by name from the list presented. Your choice will be displayed.

@GeoReference Menu (GeoRef)

This menu allows a fixed-format (free-format still in progress) coastline file and a geopolitical bounds file to be read into the session. It is intended that these files will be used as vector overlays on map images.



This collection is available as an overlay to a map image display using the OVERLAY control button found on image display windows. Non-linear projections are not yet supported. The underlying image must be of georeferenced data (having lat/long bounds). Georeferenced point overlays for map images must first be created using the point data plotting feature of GeoVu. Then these will be available using the OVERLAY button.



The image information dialog will show you that the projection is specified as Lat/Lon or you can use the Edit menu item Image Information... and click the MODIFY button to set this. Also the four range values must be set so that the image is registered within GeoVu's own map coordinates. GeoVu uses an internal coordinate system for these overlay files of -180 to 180 and 90 to -90. Only contiguous ranges within this system are used by GeoVu, although it will reset coordinates that are specified with a longitude range within 0 to 360.

�The two files used in GeoVu to provide coasts and boundaries are derived from portions of Micro World Databank II.



Pospeschil, Fred  1992.  Micro World Databank II

Coastlines, Country Boundaries, Islands, Lakes and Rivers. Digital vector data at 1 minute resolution. In: Global Ecosystems Database Version 1.0: Disc A.  Boulder, CO: NOAA National Geophysical Data Center.  6 independent single-attribute spatial layers on CD-ROM, 2.5 MB.

Load GeoVu Rivers/Coasts

Select Load GeoVu Rivers/Coasts to open the file of lat/long coordinates to be used and displayed as coastal boundary lines. GeoVu provides one world coastline data file, called COAST.DAT. If the file COAST.DAT is not found in the working directory, you will be prompted for the file name and directory with the standard open file dialog.



The binary file is in the format: one 4-byte LONG value specifying the number of pairs to follow, followed by sequential pairs of LONG coordinates (representing lat/long).This repeats for connected line segments until the end of the file. No area searches can be done on these files. GeoVu uses an internal geo-referencing system that expects a resolution multiplier value of 1000 has been applied to the range of -180 to 180 and 90 to -90.

Load GeoVu Boundaries

Select Load GeoVu Boundaries to open the file of lat/long coordinates to be used and displayed as country/state boundary lines. GeoVu provides one world boundaries data file, called BOUNDS.DAT. If the file BOUNDS.DAT is not found in the working directory, you will be prompted for the file name and directory with the standard open file dialog. This binary file has the format described above for the coastlines data.

Display GeoRef Overlay

The collection of overlay elements may also be displayed without an image under it. To create this type of display, select the menu item Display GeoRef Overlay. The controls available on this display are discussed in the section GeoRef Overlay Display Controls.

�@Utilities Menu

Slide Show...

This menu item allows you to sequentially display data sets from a fully-compatible data source. This menu item is available only when a menu file is provided that contains a section called SLIDE SHOW and that section contains the word TRUE. The description of the data collection includes this keyword to notify GeoVu that animations of image displays would be appropriate.



�

Select Slides: Title�XE "Select Slides\\: Title"�

This dialog is similar to the dialog presented by the Open Data menu item and is used to select files for display.



The Data Source box lists all items at the current level of the data menu. To select an item for the slide show, double-click the item. A * before the name of a menu item indicates that item has been selected. Double-click a selected item again to unselect the item and remove the mark. Once an item has been selected, all files under this in the menu hierarchy are selected with it. If this item is an individual file, it is at bottom level of the data source menu and no other files are selected. To select every data set available in the source, just select all items in the top-level menu.



�Facts:  Display information about the highlighted item in the list box.



Select All:  Select every item in the list box.



<<Prev:  Go back to the parent level menu of the current menu.



Next>>:  Go to the submenu highlighted in the list box.



OK:  Available only after items are selected. Click this button to start the show.



In some data collections, a prepared image file may be available, corresponding to a data file. The data producer can write the data collection's GeoVu menu file to allow the display of prepared images for, giving the extension of the image file type. For example, there may be a PCX file accompanying each real image data set. Keyword slide_show_ext should be defined as PCX in the menu file (in the default equivalence table). This notifies GeoVu that there are .PCX data files as well as original real data sets that can be used for slide shows. The following dialog will only appear if the keyword slide_show_ext was found in a menu file.

Slide shows data type�XE "Slide shows data type"�

After selecting slides, you may be asked to specify the type of data to show. The two choices will be Real Data or another type which is specified. Use of the real image data file could be slow! Choosing the prepared corresponding image of the data may be faster.

Slide Show�XE "Slide Show"�

This dialog controls the slide show. You can move this dialog window to any location, for a better look at the slide show session. The data file name shown is the current file being prepared and the percentage of the file that has been read is shown.



Step/Continuous:  This button names two modes of presentation. If the current name is Step, click this button to change the mode to Continuous. Step mode will wait for you to click the Show Next button before presenting the next slide. Continuous mode will display the next slide immediately when it is ready. In GeoVu releases since 3.01, this button is replaced by a pair of radio buttons.



�Show Next:  Display the next slide. Available only for the Step mode.



Cancel:  GeoVu will ask you whether or not to abort the slide show. If the answer is yes, GeoVu will stop the slide show, otherwise, it will return to the slide show.

Image Processes...

The Image Processes menu item will present the following dialog only if some image display window is selected as the active window.

Image Processing Utilities�XE "Image Processing Utilities"�

This allows an image display currently in a selected window to be re-computed into a new image which is smaller or is enlarged. That image will be displayed in a new display window. Note that the new image is not associated with the working data set that generates the original.

View File Histograms

Histogram information may be available as metadata to be displayed and examined. The histogram plots show the occurrences counted for values of a variable. This feature is for browsing pre-computed histogram information and does no data processing or computations.



For processing histograms of displayed images (pixel color frequency), click the HIST button found on the image display control panel.

Histograms: data set title�XE "Histograms\\: data set title"�

Each Histograms dialog works with only one open data set. To view histograms for another open data set, close this window and return to the Histograms menu item.



Variable:  Select from the list of variable choices.



XYPlots:  In the GeoVu current release, only XYPlots are shown. Later, the option of table displays will be added.



Terms:  Definitions or other information about the highlighted variable will be shown if text has been provided for this.

@Windows Menu

Status

Select this menu item to bring the status window to the front, listing open data files and searches created.

Close All Displays

This menu item removes all the display windows, but does not close files or delete searches.

(Window Titles)

The other Window menu items are titles of all the GeoVu display windows and the always-present status window. Selecting one of these titles will bring the window to the front.

@Help Menu

On a Macintosh running System 7.5 or later, this menu is under the ? Apple Guide icon on the right side of the menu bar.

Contents

This selection allows you to browse the contents of the GeoVu help text, which is the same as Part Two of this User's Guide. This same help text is available under Microsoft Windows by striking the F1 function key. Note that if the GeoVu help file was not found when the session started, there will be no response when Contents is selected.

About, On Version

This selection presents information about the GeoVu release, version number, and shows the support contact and a button for HELP Contents display. Motif releases call this item On Version.

@Interactions with the Display Windows

GeoVu Display Windows present graphics for images, plots, georeferenced points and vectors. Each has a set of button controls and customary decorations used by Windows, Macintosh, or MOTIF applications.



Under Windows, an enlarge box and a close box (and its menu) are available at the top of each window. MOTIF windows do not have the enlarge box. To resize a window, click and hold on the window's frame and drag the frame in the desired direction. Double mouse-clicks within the title bar area will enlarge and restore window size. This will also refresh the window with an updated display. If you hold the left mouse button down and drag the title bar, the window will follow the mouse movement if it is moveable.



When an entire display is not shown in the display window's drawing area, active scroll bars will appear to provide panning of the display. Under Windows, inactive scroll bars are removed but under MOTIF and Macintosh they remain visible.



See the following sections: Image Display Controls, Georeferenced Overlay Display Controls, and Plot Display Controls.

@Image Display Controls

The display of raster data is presented in an image display window, titled with the data search name. These image display features and controls are available:



> A status bar along the bottom display area is used to show results and prompts about cursor interactions. In the current release, the cursor query interactions only provide screen and image information.



> A color swatch legend shows the current color palette.



> Cursor interactions with the window: Double-mouse clicks over the image will select a point and present its row and column, color index, and other information.



> The OVERLAY dialog will be presented only when the image is georeferenced; then it toggles drawing flags and colors for georeferenced vector and point data sets, including a world grid and elements added to the session using the GeoReference Menu.



> COLOR control dialog will present a palette name list for selecting a replacement color palette and will show the current colors and data ranges. OKAY will update the image display to show the changes. CANCEL will quit the dialog without changes to the image display.



> ZOOMIN allows a region to be selected by a cursor-controlled rubber band box. You can repeat this until precision fails or the image stretch distorts too much.



> ZOOMOUT will undo the last ZOOMIN.



> SAVE the window's image only to a PC PCX file (run-length encoded or not) or a PC DIB file (this is a .bmp), or a GIF file (Motif only), or a PICT file (Macintosh only). You will be prompted for a name for the output file.

�



> PROFILE lets you enter a transect line across the image, then it creates and displays an XY-Plot defined from the color indices along that line. If the shift key is held down, you can select a series of connected points to make the transect path. Release the shift key to enter the final endpoint.



> REGION allows an area selection by clicking and dragging the mouse. You must enter a name tag for this region and it is then saved throughout the session for use in named retrievals, but this feature is still under development in releases earlier than 6.0.



> FACTS will present any text information provided about the data that is being used for the display.



> HIST (histogram) will create a plot definition from values ranging between 0.0 and 1.0 that describe the color frequencies of the image. This plot is presented in a new XY-Plot Display Window.

@GeoRef Overlay Display Controls

This type of display presents georeferenced vector and point data without an underlying map image. This is the type of display window that appears when the menu item Display GeoRef Overlay is selected from the GeoRef menu. These Overlay Display controls and features are available:



> A status bar along the bottom display area is used to show results and prompts about cursor interactions. Double-mouse clicks within the display show GeoVu vector map coordinates here.



> OVERLAY dialog toggles drawing flags and colors for session's georeferenced vector and point sets.



> ZOOMIN allows a region to be selected by a cursor-controlled rubber band box. You can repeat this until precision fails or the image stretch distorts too much.



> ZOOMOUT will undo the last ZOOMIN.



> REGION allows an area selection by clicking and dragging the mouse. You must enter a name tag for this region and it is then saved throughout the session for use in named retrievals, but this feature is still under development in releases earlier than 6.0.



Scrolling through the display of a line drawing is very slow, so you will not see the coastline or boundaries during the scrolling. When you are done scrolling you can recover the line drawing part of your display by forcing the screen to be redrawn. One way this can be done under Windows is by clicking on the title bar.

@Plot Display Controls

This type of display is a 2D data plot, also called an XY-Plot. Also see the discussion of Search dialogs. These Plot Display control features are available:



> OVERLAY toggle the grids and labels on a plot.



> LEGEND control dialog presents the name of each data set and allows changes to the display attributes of it: new line types or symbols may be specified or the data will be "undrawn" by using the CHANGE button and Change Dataset Display Attributes dialog.

Change Dataset Display Attributes�XE "Change Dataset Display Attributes"�

A drawing method is specified by using the radio buttons and setting the corresponding attributes. Also a color for gridding may be chosen.



CANCEL:  Stop the plotting process.



UNDRAW:  Removes the plot.



OK:  Accept the settings made and continue.



> ZOOMIN allows a region to be selected by a cursor-controlled rubber band box. You can repeat this until precision fails or the image distorts too much.



> ZOOMOUT will undo the last ZOOMIN.



> SAVE creates a .bmp file (or PICT file on Macintosh) from the screen image created for this plot. A standard Save File dialog will request that you enter the file name.



> DATAOUT creates a file from the data created for this plot. A standard Save File dialog will request that you enter the file name.



> REGION allows an area selection by clicking and dragging the mouse. The results are passed back to the application. Saving the regions is not yet completed in GeoVu.



> FACTS will present any text information provided about the data that is being used for the display.



> CUSTOM will allow you to customize the appearance of the plot. Future enhancements are planned.

Specify Plot Display Attributes�XE "Specify Plot Display Attributes"�

A linear or log scale may be requested. Labels may be changed here. Also a background color may be chosen.

@GeoVu Accessory Files

The files below are provided with GeoVu or generated by it. Most are not required, especially when Disk Files are the only data sources and not CDs. All of these files may not have been installed with GeoVu.

�@GeoVu's help file

This file (g2.hlp or g2_.hlp) provides the text of the instructions and the help panels�SYMBOL 45 \f "Symbol"�it is not otherwise readable. If it does not reside in the GeoVu working directory, then GeoVu will prompt for the filename. GeoVu can be run without this file but no HELP text will be displayed.



To have written documentation for GeoVu (User’s Guide and Tools Reference Guide), send the gv*.ps files found in the GeoVu installation directory to a PostScript printer.

@World Coastline, Bounds Files

GeoVu uses only two binary georeferenced vector files, derived from Micro World Data Bank II data files. The world coastline file is COAST.DAT and the geopolitical boundaries are in BOUNDS.DAT. These have a fixed format used directly by GeoVu displays. (The values are scaled by a resolution factor and are represented as longs. The files are sequences of the number of points in one continuous segment, followed by the point pairs of that segment.)

@Data Source list file

GeoVu is compatible with many CD-ROM discs and special data collections, such as the GeoVu Data Sampler. The ASCII file cdm_serv.lst contains a default drive letter specification, such as a CD-ROM reader, and a list of supported collection names or CD-ROM volume titles. This provides the selection list when you Set Data Sources in GeoVu and may be customized for your work. To do this, GeoVu provides the Edit menu item Data Source List, which will create or modify the file. It is also possible to read the file or to change it with a text editor.



Listed with each title is a specific file name, with a .men extension, which is the menu file used by GeoVu to navigate through the CD-ROM or data collection. Each line contains one title (any name you want) followed by the separator #, followed by the specific menu file name. Since GeoVu Release 5 and newer: No path or drive letter or home directory appears in the file names; these files must be in the GeoVu installation directory (GEOVUDIR).



�The menu files are distributed on CD-ROM and from ftp.ngdc.noaa.gov. Corrections and updates may appear in the ftp directory. Copy these files into your GeoVu installation directory. Not all data collections have corresponding menu files. You may also wish to write one for your data. See the GeoVu Tools Reference Guide for details.



The first line of the cdm_serv.lst file contains the keyword cd_driver (the only keyword allowed in this file) followed by the separator #, followed by the drive letter. The CD�driver specification in this file is optional. You can remove this line from the file or change it to match your drive letter. Only one drive may be specified. You can also enter or change the drive letter while running GeoVu when using the menu item Set Data Source.



On Unix systems, this will not have a drive letter but rather the file system name for the CD-ROM device or a directory path. On Macintosh the cd_driver line in the file is not used, since each CD is accessed directly using its volume name (i.e., the name of the CD appearing on the desktop).



An example found on Windows of cdm_serv.lst:



cd_driver #L:

Gravity CD #gravcd.men

Global Change CD #global.men



This example file specifies that the CD-ROM Reader drive is L:, and two CDs are currently supported: the Gravity CD and the Global Change CD. GeoVu will expect to find the two corresponding .men files to be in the GeoVu working directory.



An example found on UNIX platforms of cdm_serv.lst:



cd_driver #/cdrom0

Gravity CD #gravcd.men

Global Change CD #global.men



An example found on Macintosh of cdm_serv.lst:



Gravity CD #gravcd.men

Global Change CD #global.men



GeoVu will run without the cdm_serv.lst file. At start-up, GeoVu will try to build the list of data sources by locating all menu files (.men) in the GeoVu working directory (GEOVUDIR). If none are found, then the only data source will be disk files.

�@Menu (.men) Files

Menu Files describe the hierarchical file organization of a CD-ROM volume or data collection. They may also include descriptive "facts" text, data format specifications, header format specifications, and naming equivalence tables. We use the file extension .men for the menu file. Please read “Menu Files” and “GeoVu Keywords” in the GeoVu Tools Reference Guide for detailed information.



For each CD-ROM data volume that GeoVu must access, there must be one corresponding .men file. GeoVu menu files are distributed for many NGDC CD-ROM volumes. To add the CD-ROM title to GeoVu's data sources list, locate the menu file and update the data source list file using GeoVu's Edit menu item Data Source List. This will customize the list of available data sources you see in GeoVu.



Copy any .men files you have obtained on CD-ROM, diskette, or our ftp location, into your GeoVu working directory. This works with all the releases of GeoVu. Be sure that the files are converted into the native text, having correct end-of-line characters. This is done automatically when you use ftp in ASCII mode to get the files. On UNIX you can convert PC menu files using a command of the form tr -d’\015’ < old.men > new.men. On Macintosh, drag the menu file onto the Make-Mac EOL utility provided and choose the Mac EOL option.

@Format Specification (.afm, .bfm, .fmt) Files

GeoVu must be supplied with format specification files or format description files, as defined in the FreeForm User’s Guide. FreeForm is the Data Access module of GeoVu and is documented separately, since GeoVu is only one of many applications that use FreeForm. The user’s guide describes the syntax and naming conventions of the companion files which must be supplied along with data files. These files are used by GeoVu when reading data, but if they are not available GeoVu will try to use some default information.

@Formats list file stdform.nam

In order to read a file properly, GeoVu needs to know the data type and data format and some GeoVu reserved words (keywords) must be given meaningful equivalents. GeoVu searches for this information first in accessory files found in the directory where the data file resides. If the current data file is from a collection described in a GeoVu menu file, GeoVu also searches sections of its corresponding menu file

If the necessary information is not found, GeoVu will display a list of the standard formats from the file stdform.nam for you to select. The stdform.nam file is an ASCII file which defines commonly-used data formats, associating a name for the format type with the base filename which is used to find the format information.



You may edit stdform.nam to add new formats. Each line in the stdform.nam file contains two strings separated by a space. The first string is the name you give the format, as it will appear on the selection list of the Format Type dialog. The second part is the corresponding base file name. GeoVu will use the base to compose format file names and equivalence table file names it expects to find and use. GeoVu expects the equivalence table file to reside in the GeoVu working directory.



Example: stdform.nam is shown below, as it is distributed with GeoVu



AVHRR_GAC_1b_unpacked gac16

Binary_raster_user_defined user

ERDAS_raster erdas_ra

GEOVU_raster geovu_ra

IDRISI_raster_v3 idrisi_r

IDRISI_v4 idrisi4

McIDAS_PC_IMAGE mcidas_d

McIDAS_UNIX_IMAGE mcidas_u

PCX_Image pcx

UNKNOWN unknown



In the stdform.nam you see the GeoVu keyword: UNKNOWN, which is used if the current data file is not in one of the standard formats.



Some standard file types cannot be described by FreeForm format descriptions and GeoVu equivalence tables. They are not listed in stdform.nam but may be understood by GeoVu only because of their file extension; this is true for GIF files ending with .gif extensions. Also supported are some types of .hdf files and .mvv movie files.

@Name Table / Equivalence Table (.eqv) Files

Equivalence tables define and describe names used in a data file or used by data files of one type, equating these names to reserved keywords used in GeoVu. The text files that contain an equivalence table must have the file extension .eqv. The contents may also be placed as a section in a GeoVu menu file. Please see “Equivalence (Name) Tables”in the GeoVu Tools Reference Guide, for details. Several .eqv files are distributed with GeoVu: those used for the standard format types entered in the stdform.nam file described above.

@GeoVu's Palettes List File

The palettes list file is an ASCII text file distributed with GeoVu that contains a collection of color table definitions. At session start-up, these tables (palettes) are available to GeoVu. Other palettes list files may be supplied with CD-ROM data collections, and they may replace the start-up color palettes during run-time. The menu files for those collections may specify a file to use in place of the start-up palettes file. You may also edit file geopal.lst to add or remove or change color palettes.



This file is optional. Without this list file, GeoVu starts with only two color palettes available: a 16 pure color VGA palette and a gray scale 16 color palette.



The first line of each palette definition is *palette_name. Each name found in the file will appear in the lists in GeoVu dialogs that control your selection of color palettes. The color specification is a line of four values separated by spaces: an index, red, green, and blue. The value range for red, green, and blue is from 0 to 255. An example of color palette:



  0 55  0 67

  1  0  0 45

  2  0  0 63

  3  0  0 95

  4  0  0 127

  5  0  0 159

  6  0  0 191

  7  31 0 223

  8  0  131 195

  9  0  191 131

 10  0  187 79

 11  0  255  0

 12  139 255  0

 13 207 255  0

 14 255 255 127

 15 255 255 255



This text can be placed in the palettes list file under its name or kept in a separate file (we use the .pal extension). The separate palette file can be linked into the palettes list file:



�SYMBOL 232 \f "Wingdings" \s 10 \h�	To link the name of a palette to a .pal file on CD-ROM, the first line of the color table is replaced by &palette_file_name (with a full directory path but without CD-ROM drive letter).



�SYMBOL 232 \f "Wingdings" \s 10 \h�	To link to a palette file in the GeoVu working directory, the first line of the color table is replaced by ^palette_file_name. 



�An example from part of the geopal.lst file:



*BGY

  0 55  0 67

  1  0  0 45

  2  0  0 63

  3  0  0 95

  4  0  0 127

  5  0  0 159

  6  0  0 191

  7  31 0 223

  8  0  131 195

  9  0  191 131

 10  0  187 79

 11  0  255  0

 12  139 255  0

 13 207 255  0

 14 255 255 127

 15 255 255 255

*GVI

&\1month\mypals\gvi.pal

*QUAL

^qual.pal



The file in the above example defines three palettes: BGY, GVI, and QUAL. The palette BGY is defined directly; palette GVI is defined in the CD-ROM file \1month\mypals\gvi.pal; and palette QUAL is defined in the file qual.pal in GeoVu working directory.
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